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PREFACE

About AppleShare IP 6.0

AppleShare IP 6.0 is server software that provides World Wide Web, file sharing, mail, and
print services to clients on local area networks (LANs), intranets, and the Internet.

Key new features in 6.0 include built-in support for Windows file sharing and the IMAP mail
protocol, print service over TCP/IP, secure printing, and separate guest access for Web & File
services.

Here is a brief description of the AppleShare IP 6.0 suite of products:

The AppleShare IP 6.0 Web & File Server allows your computer to host a Web site (using
the HTTP 1.1 protocol) and provides three types of file sharing services: AppleShare File
Sharing (using the AppleTalk Filing Protocol, or AFP) via TCP/IP or AppleTalk networks,
Windows File Sharing (using the SMB/CIFS protocol via TCP/IP), and File Transfer
Protocol (FTP). You manage Web and file services using the Web & File Admin program.

The AppleShare IP 6.0 Mail Server provides integrated mail storage and mail forwarding
services over TCP/IP and AppleTalk networks, including support for Internet Message
Access Protocol (IMAPv.4), Post Office Protocol (POP3), and Simple Mail Transfer Protocol
(SMTP). You manage mail services using the Mail Admin program.

The AppleShare IP 6.0 Print Server manages communication with the printers on your
AppleTalk or TCP/IP network by allowing the server to act as a repository for print jobs.
The Print Server also allows you to set up secure print queues to control who can print.
You manage print services using the Print Admin program.

AppleShare Client 3.8 is the software that allows Mac OS client computers to use
AppleShare file sharing services. You need to install this software on your Mac OS client
computers.

MacDNS software provides Domain Name System (DNS) service for your network. You
need to install DNS software in order to communicate with the Internet and to allow
users to enter names instead of numeric IP addresses when, for example, sending e-mail.

For detailed information on these product features, see AppleShare IP Help after completing
the instructions in this manual. To access AppleShare IP Help, see “What'’s Covered
Onscreen.”
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AppleShare IP 6.0 also comes with additional software to help you run your servers more
effectively and efficiently. See the folders and files on your AppleShare IP 6.0 CD.

What’s Covered in This Manual

This manual provides instructions on how to install and set up the AppleShare IP 6.0
software. Once you've installed and set up the appropriate software on your server and client
computers, you can refer to the onscreen documentation for information about using the
software.

What’s Covered Onscreen

Your main sources of information about AppleShare IP 6.0 are Tips and AppleShare IP Help
(described below).

You'll also find Read Me files and other onscreen documents in the AppleShare IP 6.0 folder.
These documents contain late-breaking news or instructions on how to use other software
that comes with AppleShare IP 6.0.

For product updates and other information, be sure to visit the AppleShare IP Web site at

http://www.apple.com/appleshareip

Tips

Tips provides an unobtrusive way of reminding you about the function of the AppleShare IP
6.0 administration program buttons. To use Tips, position the pointer over a button in the
window of an AppleShare IP 6.0 program. After a fraction of a second, the tip appears below
the button, as shown in the following example.

[0 =— AppleShare IP Manager =——H
Adrmin Status

e ‘Web & File Admin: Running
@ ‘Web & File Server: Running————
Open eb & File Admin | ieb: Erabled

#ppleShare via TCP: Enabled
FTF: Enabled

‘windows File Sharing: Disabled




AppleShare IP Help

If you have a question about how to use AppleShare IP 6.0, open any of the AppleShare IP 6.0
administration programs and choose Help from the Help menu. Choosing Help opens
AppleShare IP Help in your preferred Web browser program. AppleShare IP Help explains
how to use the AppleShare IP 6.0 software and troubleshoot problems that may arise while
using the software.

You can also open AppleShare IP Help by double-clicking its icon in the AppleShare IP 6.0
folder.

]

—n
o=

AppleShare [P Help

AppleShare Client User’'s Manual

The “AppleShare IP Client 3.8 User’s Manual” (inside the AppleShare Client 3.8 folder)
provides instructions on how to install the AppleShare Client 3.8 software on Mac OS client
computers and how to use this software for AppleShare file sharing.

Before you direct users to the “AppleShare IP Client 3.8 User’s Manual,” be sure to complete
all of the setup and installation instructions in this manual.

MacDNS Administrator’s Guide

The “MacDNS Admin Guide.pdf” file (inside the MacDNS folder on your AppleShare IP 6.0
CD) provides instructions on how to use the MacDNS software to provide DNS service on
your network.

About AppleShare IP 6.0 7






CHAPTER

Installing AppleShare IP 6.0

Whether you are upgrading from a previous version of AppleShare or installing it for the first
time, you need to follow the instructions in this chapter.

This chapter tells you how to

= plan your AppleShare IP services

m prepare your computer’s environment and software

n install AppleShare IP 6.0

Note: Your server should already be set up and connected to your network. If your server or
network is not set up, set it up before continuing with this chapter.

Important The AppleShare IP 6.0 license agreement allows you to install and use the server
software (or the individual components thereof ) on a single computer. This agreement
allows you to install the individual server programs on different computers; it does not allow
you to install the same server software on more than one computer at a time. To install the
server software on more than one computer, you need to purchase additional copies of the
software. For more information, see the license agreement that appears when you install the
AppleShare IP 6.0 software.

Planning Your AppleShare IP Services

Depending on the services you plan to provide to your users and on how your network is set
up, you'll need to answer the following questions before you install AppleShare IP.

»  Will your clients be connecting to the AppleShare IP server via AppleTalk, TCE/IP, or both?
= What types of clients are on your network—Mac OS, Windows, UNIX?

»  What type of physical connection (for example, Ethernet or LocalTalk) does your
AppleShare IP server have to your intranet or the Internet?

m What is your server’s IP address, subnet mask, router address, and name server address?

= Does your network have a computer that is providing Domain Name System (DNS)
service?
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Your network administrator should be able to help you answer these questions. If you do not
have a network administrator or if you need more assistance, use the “Network
Configuration Setup Guide” in the Tutorials folder on your AppleShare IP 6.0 CD. You may
also want to consult an Internet service provider (ISP) to help you answer these questions
before continuing with your AppleShare IP installation.

Preparing Your Computer’s Environment

Before you install your AppleShare IP 6.0 software, you need to prepare your computer and
its environment. You prepare your computer’s environment by making sure you've
considered security issues, hardware and software requirements, and facts about upgrading.

Security

AppleShare IP 6.0 uses share points, user authentication, and access privileges to protect data
from unauthorized access over a network. That protection can be bypassed by someone with
physical access to your computer. (Access privileges, for example, allow or deny access over
the network; they cannot prevent someone from opening a folder directly on the computer
running AppleShare IP.)

Note: Not all AppleShare IP services support these security measures to the same extent.
For more information, see AppleShare IP Help after you complete the instructions in this
manual.

If you have any concerns about physical security—especially if you plan to store highly
confidential information—consider putting your computer in a separate room with
controlled access. If no such room is available, consider installing a screen-saving application
that requires a password to unlock the computer.

System Requirements

To install the AppleShare IP 6.0 software, you need the following hardware and software:

» Hardware: Any Apple Power Macintosh computer or Apple Workgroup server with a G3,
604e, 604, or 601 processor, or a 6500 series computer with a 603e processor. Your
computer should be set up and connected to your network.

To use the multihoming feature of AppleShare IP (described in the Web & File section in
AppleShare IP Help), your computer must have a Peripheral Component Interface (PCI)
expansion slot. Computers with a 601 processor and NuBus™ slots cannot use
multihoming.

The AppleShare IP 6.0 Print Server only works with AppleTalk-compatible LaserWriter
printers, third-party PostScript™ printers that support the Apple LaserWriter 8.4 printer
driver, and TCP-compatible printers that support the LPD/LPR protocol.



» Disk space: You need approximately 25 megabytes (MB) of disk space to install all of the
AppleShare IP 6.0 software. For the best server performance, you may want to install one
Or MOre Server programs on a separate computer.

For example, by installing the Web & File software on one server and the print and mail
software on another, you can “balance the load” on AppleShare IP 6.0 services. This
practice often improves performance and reliability for high-volume services.
Alternatively, you may want to install all AppleShare IP software on one server, and other
server applications—for example, backup software or a gateway or router—on another
server.

Important Be sure to check the AppleShare IP 6.0 license agreement (you can print it
when you install AppleShare IP) for restrictions on installing the AppleShare IP software
using one serial number

Note: For instructions on moving the Mail Server after it has been installed, see the Mail
Server section in AppleShare IP Help.

» Memory: You need 48 MB of memory with virtual memory turned on to run all of the
AppleShare IP servers simultaneously. To run all of the AppleShare IP servers without
turning on virtual memory, you need a minimum of 64 MB of random-access memory
(RAM).

To run each server on a separate computer, you need at least 32 MB of RAM with virtual
memory turned on.

n System software: Mac OS 8.1 or later. (If your computer is using an earlier version of
system software, follow the instructions in “Installing Mac OS 8.1” when you reach

page 13

If You Are Upgrading

If you are upgrading from AppleShare 3 or 4, AppleShare IP 5, or Macintosh file sharing, you
should be aware of the following information about preserving files and settings.

Users & Groups

If you are upgrading from AppleShare 3 or 4, AppleShare IP 5, or Macintosh file sharing, the
registered users and groups that you've created are retained when you install
AppleShare IP 6.0.

Shared Folders and Access Privileges

If you have shared folders on another computer that you'd like to move to your

AppleShare IP 6.0 server, you need to follow the instructions in this manual to install and set
up AppleShare IP 6.0 on the new server. Then follow the instructions for moving shared
folders in the Web & File section in AppleShare IP Help.

Installing AppleShare IP6.0 11
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Note: Any access privileges of folders you move that don't exactly match the new access
privileges in AppleShare IP 6.0 are converted to the closest match that provides the most
security. For more information about access privileges in AppleShare IP 6.0, see the Users &
Groups section of AppleShare IP Help.

Print Queues

If you're upgrading from a previous version of the AppleShare Print Server, your Print Server
setup is not retained. You will need to create new queues after you install AppleShare IP 6.0.
(You will create a queue when you set up the Print Server in the next chapter.)

File Sharing & Networking Software Settings

If you are upgrading from AppleShare 3 or 4, or AppleShare IP 5, the settings in your File
Sharing, AppleTalk, and TCP/IP control panels are retained. You do not need to reconfigure
these control panels as described in “Preparing Your Computer.” You should, however, still
perform the other tasks in that section.

The Mail Database

If you're upgrading your AppleShare IP 5.0 Mail Server to the 6.0 Mail Server, make sure your
Mail Server users download all their mail before you upgrade. If you don’t empty the 5.0 Mail
Server database before installing the AppleShare IP 6.0 Mail Server, you'll need to use the
AppleShare IP Mail Tool program to update the 5.0 Mail Database to version 6.0 after you
install the new software. (You can find the AppleShare IP Mail Tool on the AppleShare IP 6.0
CD.)

Preparing Your Computer

Once your environment is ready, you need to prepare your computer for running
AppleShare IP 6.0 by installing and configuring the appropriate software. You need to do the
following:

» back up the necessary files

» install Mac OS 8.1

» set up your network identity

» set up AppleTalk

n setup TCP/IP

» set up TCP/IP and PPP (for modem access only)
= set up Energy Saver

» verify your computer’s date, time, and time zone



Backing Up Necessary Files
Depending on the file sharing program and system software version you've been using, you
may want to make backup copies or record certain information before proceeding.

= Ifyou're upgrading from a previous version of AppleShare or AppleShare IP, back up your
System Folder using a backup application that can copy invisible files. Backing up will
allow you to restore a copy of the previous Users & Groups Data File and the AppleShare
PDS file (an invisible file installed on every volume), and make it possible for you to
switch back to your previous version of AppleShare if you desire.

Note: When you make your backup copy, make sure that the AppleShare IP Web & File
Server is running.

» Ifyou're upgrading from Macintosh file sharing, you only need to make a backup copy of
your Users & Groups Data File. The Users & Groups Data File is located in the
Preferences folder inside the System Folder on your startup disk.

» If you've been using MacTCP for network communications, open the MacTCP control
panel and write down your computer’s IP address and the IP addresses of name servers
and routers. You need to copy down this information before you upgrade your system
software. You'll use it later to configure the TCP/IP control panel.

Installing Mac OS 8.1

If your computer is running a version of system software that is earlier than Mac OS 8.1, you
need to upgrade to Mac OS 8.1 before you install AppleShare IP 6.0.

If your computer is already using Mac OS 8.1, skip ahead to “Setting Up Your Network
Identity” on page 14.

To install Mac OS 8.1, follow these steps:

Insert the Mac OS 8.1 CD-ROM disc that came with your AppleShare IP 6.0 software into your
computer’s CD-ROM drive.

Double-click the Installer icon.
Follow the instructions on the screen to get to the Easy Install screen.
Install Mac OS 8.1 and OpenDoc 1.2.1.

If you use Easy Install, be sure to click the checkbox next to OpenDoc 1.2.1 (so that a
checkmark appears) to install all the system software you need to use AppleShare IP 6.0.

If you choose to do a custom installation, be sure to include OpenDoc 1.2.1,
Open Transport 1.3, and Apple Browser Launcher 1.0.

After the installation is complete, click Restart to restart your computer.

Installing AppleShare IP6.0 13
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Setting Up Your Network Identity

You need to set your network identity and password in the File Sharing control panel to be
able to log on to the servers and make yourself the default owner of shared disks.

Note: Ifyou're upgrading from a previous version of AppleShare or if you used the Mac OS
Setup Assistant after installing Mac OS 8.1, your file sharing settings will be retained. You can
skip ahead to “Setting Up Energy Saver” on page 23.

To set up the File Sharing control panel, follow these steps:
Open the File Sharing control panel.

Click the Start/Stop tab to see the Network Identity section.

O0=—————FileSharinn="————H

start/stop \ / Activity Monitor

@ Network Identity 2
[5teph Koester |

Owner Name:

Computer Name: Imgser\-’er |

Type your name in the Owner Name text box and press Tab.

Type the name you want to use when you log on to administer an AppleShare IP 6.0 server.
The name that you type will also be the default “owner” name for any items that you share.
The name is not case-sensitive. When you type this name to log on to the server, you can
type it with upper- or lowercase letters.

Type your password in the Owner Password text box and press Tab.

Your password can be up to eight characters long. Passwords are case-sensitive, so remember
any letters that you capitalize so that you can log on successfully. The password you enter
here becomes the default password you need to enter to use the AppleShare IP
administration programs.

After you press Tab, each letter of your password is replaced by a bullet ().
Type a name for your server in the Computer Name text box.

The name can be up to 31 characters long and can contain any character except a colon (:),
equal sign (=), or Optionx (=). The Computer Name is the name for your AppleShare IP
server that will appear in the Chooser.

Close the File Sharing control panel.

Your changes are saved and take effect immediately.



Setting Up AppleTalk

In order to provide file sharing, print, or mail services over AppleTalk, you need to set your
AppleTalk network connection in the AppleTalk control panel.

Note: If you're upgrading from a previous version of AppleShare or if you used the Mac OS
Setup Assistant after installing Mac OS 8.1, your AppleTalk settings will be retained. You can
skip ahead to “Setting Up Energy Saver” on page 23.

To set up the AppleTalk control panel, follow these steps:

Open the AppleTalk control panel.

O =——7—=—anpleTalk=—7--=H
Connest via: [ Ethernet slot B1 %)
Setup
’7 Current zone: | East wing 3
2

Choose the network connection type that you want AppleTalk to use from the “Connect via”
pop-up menu.

This setting determines the default port that your server will use to connect to your
AppleTalk network.

If the default port becomes unavailable (for example, if your Ethernet cable becomes loose),
AppleTalk will choose one of the other available network connection types.

If your network has zones, choose the zone in which you want your AppleShare IP Web &
File Server to appear from the “Current zone” pop-up menu.

Zones are groups of devices arranged according to logical categories, such as usage or
geography. If your network has a “router” (a device used to connect networks), then it will
also have zones. Choose the zone in which you want your server to appear when listed in the
Chooser.

If your network does not have a router, all computers connected to the network are
considered to be in the same zone, and you see “no zones available” instead of the pop-up
menu.

Close the AppleTalk control panel and save your changes.

Your changes are saved and take effect immediately.

Installing AppleShare IP6.0 15
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Setting Up TCP/IP

In order to enable users to use file sharing services over TCP, visit your Web site, or use TCP-
based client mail or FTP applications, you need to set your computer’s network connections
in the TCP/IP control panel.

Note: If you have already set up your TCP/IP control panel or completed the Internet Setup
Assistant after installing Mac OS 8.1, you do not need to follow the instructions in this
section. Skip ahead to “Setting Up Energy Saver” on page 23.

Important If you plan to install an AppleShare IP server on this computer and use a dial-up
(modem) connection to the Internet, skip these instructions and go to “Setting Up TCP/IP
and PPP (for Modem Access Only)” on page 18.

Important If your Internet service provider has provided you with software that
automatically configures your TCP/IP control panel, do not change the settings made by the
ISP software program. Skip ahead to “Setting Up Energy Saver” on page 23.

To set up the TCP/IP control panel, follow these steps:

Open the TCP/IP control panel.

If TCP/IP is inactive, the following dialog box appears.

TCP/IP is currently inactive.
Changes won't take effect until TCP/IP is made
active again.

Make TCP/IP active when closing the control
panel?

No ][ ves |

Click Yes.

The TCP/IP control panel appears.
Choose User Mode from the Edit menu.
The User Mode window appears.

Click Basic, if it's not already chosen. Then click OK.
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The TCP/IP window shows the basic TCP/IP options.

EiI=————— TCP/IP
Connect via: Ethernet bl l
e Setup
Confiqure: Manually bl |
IP Address: | |
Subnet razk: | |
Router address:
Search demains
Name serwer addr.:
2

Choose the network connection you are using to connect over TCP/IP from the “Connect via”
pop-up menu.

This setting determines the port that your server will use to connect to your TCP/IP network.
Choose Manually from the Configure pop-up menu.
Type the IP address for your AppleShare IP server in the IP Address text box.

An IP (Internet Protocol) address is a set of four numbers from 0 to 255, separated by dots
(for example, 172.16.54.2). It identifies your server (the computer that will be running the
AppleShare IP software) on the network. Your network administrator or Internet service
provider should provide this address.

Important Each computer has a unique IP address. Entering an incorrect address or the IP
address that another computer uses can cause problems with your computer and with the
network. Be sure to enter your server’s exact address.

Type your network’s subnet mask in the “Subnet mask” text box.

Like an IP address, a subnet mask is a set of four numbers from 0 to 255, separated by dots
(for example, 255.255.252.0). Your network administrator or Internet service provider
should provide you with this information. If you leave this field blank, you will be assigned a
default subnet mask.

If your network has a router, type its address in the “Router address” text box.

A router is a device that connects two or more networks and directs information along the
most efficient or appropriate network path. Routers also have IP addresses.

Type the IP address of your network’s Domain Name System (DNS) server in the “Name
server addr” text box.

Installing AppleShare IP6.0 17
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11

A domain name (or DNS) server lets users identify computers by name instead of by IP
address. You can specify as many name servers as you want as long as you press Return after
each address, and you do not type more than 255 characters.

If no other computer on your network provides DNS service, you can install MacDNS—an
implementation of DNS for the Mac OS. AppleShare IP Easy Setup (described in Chapter 2)
will set up and start MacDNS on your server. If you plan to use MacDNS, type the IP address
of the computer on which you will install MacDNS in the name server address text box.

Important [n order for your clients to be able to identify computers by name, and for you
to provide mail services, your network must have a domain name server. The computer name
it issues is called the “DNS name” or “host name.”

Close the TCP/IP control panel and save the changes you have made.

Your changes are saved and take effect immediately.

Setting Up TCP/IP and PPP (for Modem Access Only)

If you will use this computer to run any of the AppleShare IP services with a modem (or “dial-
up”) connection to the Internet, you need to set up the TCP/IP control panel using a Point-to-
Point Protocol (PPP), such as PPP.

Note: If your server uses a modem for TCP/IP connections, the only way client users will be
able to use AppleShare file sharing services is via AppleTalk.

If you're using a dial-up connection, you've probably opened an account with an Internet
service provider and been assigned one or more IP addresses. The steps you need to follow
to set up TCP/IP for Open Transport/PPP depend on whether your Internet service provider
has assigned your server a static or dynamic IP address.

With static addressing, your ISP assigns each computer on your network a unique IP number.
With dynamic addressing, your ISP assigns a different IP address to each computer each time
it connects to your ISP. Using a dynamic IP address for your server has the following effects
on the Web & File Server:

»  Mac OS clients on your network will not be able to use TCP/IP to connect to the
AppleShare IP Web & File Server. Instead, they will have to use AppleTalk.

»  Windows clients will not be able to connect to the Web & File Server.
» Users will be unable to visit your Web site.
m Users will not be able to use FTP to connect to the AppleShare IP Web & File Server.



Because of the disadvantages of using dynamic addresses, Apple recommends you obtain a
static IP address for each computer on which you will install AppleShare IP services.

Important If your ISP has provided you with software that automatically configures your
TCP/P control panel, do not change the settings made by the ISP software program. Skip
ahead to “Setting Up Energy Saver” on page 23.

If your computer uses a modem to connect to your Internet service provider and has a static
IP address, follow these steps to set up TCP/IP and PPP:
Open the TCP/IP control panel.

If TCP is inactive, the following dialog box appears.

TCP/IP is currently inactive.
Changes won't take effect until TCP/IP is made
active again.

Make TCP/IP active when closing the control
panel?

Mo ]H Yes ]l

Click Yes.

The TCP/IP control panel appears.

Choose User Mode from the Edit menu.

The User Mode window appears.

Click Basic, if it's not already chosen. Then click OK.
The TCP/IP window shows the basic TCF/IP options.

Installing AppleShare IP6.0 19



5 Choose PPP from the “Connect via” pop-up menu.

O ——"r———=—"TCP/IP (Maclp) ———————"xH
Connect via: [ FFF ij
— Setup
Configure: [ ManuaTly B
IF Address: | |
Subnet mask: < will be supplied by server »
Router address: < will be supplied by server »
Search domains
Marne server addr.:
2

Choose Manually from the Configure pop-up menu.

7 Type your computer’s IP address in the IP Address text box, and the IP addresses of your
ISP’s domain name server in the “Name server addr” text box.

Your ISP will provide the information that you use to fill in the “IP Address” and “Name server
addr” boxes. For descriptive information about these settings, see steps 7 and 10 in “Setting
Up TCP/AIP” on page 16.

8 Close the TCP/AP control panel and save the changes you have made.

Your changes are saved and take effect immediately. Next you need to set up the PPP control
panel.

9 Open the PPP control panel.

20 Chapter 1
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The PPP control panel appears.

O0=———————rPP=———-7--0©1H

Connect via: Madern

— Connection

@ Registered User o Guest

Marne : | |

Password: | |

D Sawe password

Murnber : | |

— Status

Idle.

2 (_options... | | connect |

Click the Registered User radio button.

Type your name in the Name text box.

Use the name that your ISP assigns to you.
Type your password in the Password text box.

Use the password that your ISP assigns to you.

Click the Save Password checkbox so that a checkmark appears.

Type the phone number of your ISP in the Number text box.
Choose Modem from the PPP control panel’s PPP menu.

The Modem control panel appears.

O acasModem ——""——"—720H

Connect wia: | Modern Port | ¥

Setup

Modenn : [_ZCom Impact Analog 144 | %]
Sound @ on (O off
Dialing: @ Tone () Pulze

D lgnare dial tone

2

16 Choose the port to which your modem is connected from the “Connect via” pop-up menu.

Installing AppleShare IP 6.0
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Choose the name of your modem from the Modem pop-up menu.

If you do not see your modem listed in the Modem pop-up menu, you need to install your
modem software. For instructions, see the documentation that came with your modem.

If you want to hear the modem when it dials, click the “Sound: On” radio button.

If the telephone line that your modem uses supports tone dialing, click the Tone radio
button. Otherwise, click the Pulse radio button.

If you don’t want the modem to wait for a dial tone before it begins dialing, click the “Ignore
dial tone” checkbox so that a checkmark appears.

Close the Modem window.
In the PPP window, click the Options button.

The following dialog box appears.

Options
Redialing \/ Connection \/ Protocol \
Redial: [ Off i]
2 [ cancel | [ ok |

If you want the modem to redial automatically when it fails to connect, choose “Redial main
number only” from the Redial pop-up menu.

Enter the number of times you want the modem to redial and the number of seconds to wait
before each attempt.

Or, if you choose “Redial main number and alternate numbers” from the pop-up menu, enter
the number of redial attempts, the seconds between attempts, and the alternate telephone
number that is to be dialed.

Click the Connection tab.
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The following information appears.

Options

Redialing V Connection \/ Protocol \

|z Connect autornatically when starting TGP/ IP applications

D Use werbose logging
Reminders :
E Flazh izon in menu bar while connected

D Prompt every 5 minutes to maintain connection

|z Dizconnect if idle for rinutes

& [ cancel | [ ok ||

Click the “Connect automatically when starting TCP/IP applications” checkbox so that a
checkmark appears.

Enabling this feature allows the Mail Server to maintain an open connection with the DNS
server so that it can obtain DNS information as needed (to send outgoing mail or check for
incoming mail).

Click the “Disconnect if idle” checkbox so that a checkmark appears.

To change the default of 10 minutes, type a different number in the text box.

Note: The Mail Server will disconnect as soon as it has completed checking for or sending
mail.

Note: o learn about the other items in this control panel, choose Show Balloons from the
Help menu and point to the item you want to learn more about.

Click OK to close the PPP control panel.

Your changes are saved and take effect immediately.

Setting Up Energy Saver

You need to make sure your Energy Saver control panel is set up correctly so that your server
doesn’t go to sleep while it’s in use and so that it restarts if there’s a power outage.

Note: The Energy Saver control panel can only be configured on PCI-based computers. If
your computer has NuBus slots, skip this section and go to “Verifying the Computer’s Date,
Time, and Time Zone” on page 25.

To configure the Energy Saver control panel for your server, follow these steps:
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1 Open the Energy Saver control panel.

| Energy Saver=———————H

Scheduled Startup
& Shutdown

Sleep
B Setup

’7Put the system to sleep whenever it's inactive for

[ Shut down instead @

of sleeping. ' . ' . ' . i '

Sleep is a low-power mode. Waking up -
2 from sleep is faster than restarting. Show Details

Make sure that the “Shut down instead of sleeping” box is not checked.
Drag the system sleep slider all the way to the right to “Never.”

Click the Show Details button and make sure that the “Separate timing for hard disk sleep”
checkbox is not checked.

Energy Saver=—"————— =

Scheduled Startup
& Shutdawn

Sleep
8 Setup
—_Put the system to sleep whenever it's inactive for

[ Shut down instead : @J

of leeping. ' . i . i . ' 1

— [[]Separate timing for display sleep

Smin 10 20 30 40 S50 &0 Newver

—[]Separate timing for hard disk sleep

30 min 40 S50 &0 Mewer

Sleep is a low - power mode. Waking up - -
2 from sleep is fagter than restarting. Hide Details

5 Choose Server Settings from the Preferences menu.

The Server Settings window appears.

Server Settings

[ Restart automatically after a power failure.

B4 Never put the hard disk to sleep.

2 cancel | [[_ok ||
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Click the “Restart automatically after a power failure” checkbox so that a checkmark appears.
Click the “Never put the hard disk to sleep” checkbox so that a checkmark appears.

Click OK.

Close the Energy Saver control panel.

Your changes are saved and take effect immediately.

Verifying the Computer’s Date, Time, and Time Zone

Since the computer’s internal date and time settings are the source for all date and time
entries in your AppleShare IP server records, you need to verify that the date, time, and time
zone are correct in the Date & Time control panel.

Open the Date & Time control panel.

O=——————nate&Tlime=——=—H
E@ Current date Currenttime
Ez S e
@ Time Zone @ Menubar Clock
The time zone has not been @& Oon () Off
specified.
[ Daylight Savings Time

Click the Set Time Zone button.
The city list appears.

Choose the city that is closest to where you are located and in the same time zone. Then
click OK.

Make sure your computer’s date, time, and daylight savings time settings are correct for your
location.

Close the Date & Time control panel.

Installing AppleShare IP 6.0 Software

You can install the AppleShare IP 6.0 software using either the Easy Install or the Custom
Install procedure, as described in the following sections.

If you plan to run all of the AppleShare IP servers on the same computer, Easy Install is the
most convenient installation procedure.
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If, instead, you plan to balance the load and install one or more server programs on a
separate computer (as mentioned in “System Requirements” on page 10), you should use the
Custom Install option to choose which server software you install on each computer. (Be
sure to check your license agreement and the “System Requirements” section for
information about installing server software on separate computers.)

Installed Files

If you use the Easy Install procedure, the following files and folders are installed at the root
level on your computer’s hard disk:

» The AppleShare IP 6.0 folder is placed on each volume on which you install the
AppleShare IP 6.0 software. It contains the following folders and files:

AppleShare IP 6.0 Read Me, which contains late-breaking information that could not be
included in this manual or the onscreen AppleShare IP Help.

AppleShare IP Easy Setup, a program that you use after installing AppleShare IP 6.0 to
perform first-time setup tasks for the installed server software.

AppleShare IP Help, an HTML document that explains how to administer your servers
using AppleShare IP 6.0’s administration programs. AppleShare IP Help can also be
opened when any AppleShare IP administration program is open by choosing Help
from the admin program’s Help menu.

AppleShare IP Manager, a program that provides an easy way to access the
AppleShare IP 6.0 administration programs.

The AppleShare IP Mail Server folder, which contains the Mail Admin program, the
AppleShare IP Mail Tool, and an alias to the Mail Server.

The AppleShare IP Print Server folder, which contains the Print Server Admin program.

The AppleShare IP Web & File Server folder, which contains the Web & File Admin
program and an alias to the AppleShare IP Web & File Server.

The Help Files folder, which contains the HTML documents for AppleShare IP Help.

The MacDNS folder, which contains a Read Me file for MacDNS, the MacDNS program,
and the “MacDNS Admin Guide.pdf.”

SimpleText, a simple word-processing program that opens Read Me files.

» The AppleShare Client 3.8 folder is placed on your startup disk. This folder contains an
Installer program, the “AppleShare IP Client 3.8 User’s Manual,” and the AppleShare
Client 3.8 Chooser extension.

» The Web Folder is placed on your installation disk. This folder contains a file named
Default.html (which the AppleShare IP Web & File Server uses as your default home
page), plug-ins, and other files.

n The AppleShare IP Preferences folder is installed in the Preferences folder inside the
System Folder.



» The AppleShare IP Editors folder is installed in the AppleShare IP Admin Libraries folder
in the Editors folder in the System Folder.

» The following files and folders are installed in the Extensions folder inside the System
Folder on your startup disk:

» AppleShare IP Libraries

» AppleShare IP Mail Config

» AppleShare IP Mail Server

= AppleShare IP Print Config

» AppleShare IP Print Server

» AppleShare IP UAM

n AppleShare IP Registry

» AppleShare IP Registry API

» AppleShare IP Web & File

m AppleShare IP Web & File Config
» AppleShare IP Web & File Server
n  ASIP Mail Guide

m  ASIP Print Guide

n ASIP WebFile Guide

= PC Net Exchange, an extension that helps users of Macintosh computers share DOS
and Windows files over an AppleTalk network

If you use the Custom Install procedure, a subset of these files and folders are installed on
your installation disk.

Performing an Easy Installation
To use Easy Install, follow these steps:

Insert the AppleShare IP 6.0 CD-ROM disc into your computer’s CD-ROM drive and open the
AppleShare IP 6.0 CD-ROM disc icon.

Open the AppleShare IP Installer folder.
Double-click the Installer icon.

The Welcome dialog box appears.

Click Continue.

A dialog box containing a license appears.

To display the license agreement in the language that is appropriate for you, choose a
language from the pop-up menu.
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You may want to print a copy of the license agreement for your records or future reference.

6 Read the license and if you agree to its terms, click Agree.

10

The following dialog box appears.

Install AppleShare IP="——"~———=H B

[ Easy Install |

Click the Install button to install AppleShare IP for Mac 05 8.1
= AppleShare IPWeb & File 5erver

» AppleShare IP Print Server

= AppleShare IP Mail Server

= AppleShare Client Network Install

* hMacDNS
r—Destination Disk
Hardlvisk Switch Disk Install "

///

Verify that the correct destination disk is named in the lower-left corner of the Installer
window.

To install the AppleShare IP software on a different disk, click Switch Disk until the name of
the disk where you want to install the AppleShare IP 6.0 software appears.

Click Install.

If other programs are open, a message states that installation is not possible until you quit
the open programs. Click Continue to quit the other programs and begin the installation.

Onscreen messages inform you of the progress of the installation. When the installation is
complete, this message appears.

s Installation was successful. You must
now restart your Macintosh to use your

new software.

Click Restart.
Your computer restarts.

Remove the AppleShare IP 6.0 CD-ROM disc from the CD-ROM drive and store it in a safe
place.



Now that you've installed the AppleShare IP 6.0 software, go to Chapter 2, “Setting Up
AppleShare IP 6.0,” on page 31.

Performing a Custom Installation
To perform a custom installation, follow these steps:

1 Insert the AppleShare IP 6.0 CD-ROM disc into the CD-ROM drive and open the AppleShare
[P CD-ROM disc icon.

Open the AppleShare IP Installer folder.

Double-click the Installer icon.

When the Welcome dialog box appears, click Continue.
A dialog box containing a license appears.

5 To display the license agreement in the language that is appropriate for you, choose a
language from the pop-up menu.

You may want to print a copy of the license agreement for your records or future reference.
6 Read the license and if you agree to its terms, click Agree.

The following dialog box appears.

Install AppleShare IP=——"———0H

[ Easy Install hd |

Click the Install button to install AppleShare IP for Mac 05 8.1
= AppleShare IPWeb & File Server

+ AppleShare IP Print Server

* AppleShare IP Mail Server

= AppleShare Client Network Install

* MacDNS
r—Destination Disk
Hardmvisk Switch Disk Install "

4

7 Choose Custom Install from the pop-up menu in the upper-left corner of the Install
AppleShare IP dialog box.
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The Installer displays the Custom Install options.

=———— Install AppleShare P =""——~—H B

[ Custominstall  w]
Check features to be installed

[ Appleshare IPWeb & File Server

[ AppleShare IP Print Server

@
@
[ AppleShare IP Mail Server ]
@

[ Appleshare Client Network Install

Disk space available : 754, 728K Selected gize : zero K

r—Destination Disk
Hardlvisk Switch Disk Install

///

8 Click the checkboxes next to the AppleShare IP software you want to install.

Note: Click the “i” button to the right of any item to see information about that item.

9 Verify that the correct destination disk is named in the lower-left corner of the Installer

10

11
12

window.

To install the AppleShare IP software on a different disk, click Switch Disk until the name of
the disk where you want to install the AppleShare IP 6.0 software appears.

Click Install.

If other programs are open, a message states that installation is not possible until you quit
the open programs. Click Continue to quit other programs and begin the installation.

Onscreen messages inform you of the progress of the installation.

When the installation is complete, this message appears.

s Installation was successful. You must
now restart your Macintosh to use your

new software.

Click Restart.
Remove the AppleShare IP 6.0 CD-ROM disc and store it in a safe place.

Now that you've installed AppleShare IP 6.0, go to the next chapter to set up your
AppleShare IP 6.0 server.



CHAPTER

Setting Up AppleShare IP 6.0

Whether you've just upgraded from a previous version of AppleShare or installed it for the
first time, you need to follow the instructions in this chapter before you can use
AppleShare IP 6.0.

This chapter tells you how to

» use AppleShare IP Easy Setup to set up and start your AppleShare IP servers

» use the AppleShare IP Manager and Web & File Admin programs to set up users and
groups and do other required “first time” tasks

» get client users ready to use the services that AppleShare IP 6.0 provides

Using AppleShare IP Easy Setup

You need to use the AppleShare IP Easy Setup program before you can use
AppleShare IP 6.0. AppleShare IP Easy Setup asks a few questions about how you plan to use
AppleShare IP 6.0 and sets up your AppleShare IP servers accordingly.

Important If you installed one or more AppleShare IP 6.0 server programs on different
computers, you need to use the AppleShare IP Easy Setup program on each computer on
which you installed an AppleShare IP 6.0 server program.

To use AppleShare IP Easy Setup, follow these steps:

Open the AppleShare IP 6.0 folder on your startup disk and double-click the AppleShare IP
Easy Setup icon.

31



AppleShare IP Easy Setup opens.

m

AppleShare IP Easy Setup

Welcome to AppleShare |P Easy Setup

Yfou can use AppleShare P Easy Setup to set up the following
FEFVErS:

# ‘Web & File Server, which shares files over a network

» [Mail Server, which manages E-mail
» Print Server, which manages printers and print jobs

To cantinue, click the right arrow.

(4] ]

2 (Click the right arrow in the lower-right corner of the window.

The screen that appears next depends on whether you've entered your computer’s IP
address in the TCP/IP control panel.

3 Ifyou've entered your computer’s IP address in the TCP/IP control panel, click the button for
a Normal or Custom setup. Then click the right arrow.

AppleShare IP Easy Setup

Select Normal or Custom Setup

e

Click Normal if your computer connects to an Intranet and/or o the
Internet using a service provider.

Click Custom if your computer connects to an Intranet only. This setup
is for computers that connect to networks that do not have a service
provider and that need to be set up with MacDNS.

@ MNormal (O Custom

To continue, click the right arrow.

[«1 [2]

If Domain Name System (DNS) service is available on your network (either from a computer
that is running DNS software or from an Internet service provider), make sure that the
Normal button is active, then click the right arrow. Now skip ahead to “Normal Setup” on
page 34.
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If DNS service is not available on your network, click the Custom button, then click the right

arrow. Now skip ahead to “Custom Setup” on page 36.

If you have not entered an IP address for your computer in the TCP/IP control panel, click the
button that describes the networks over which you want to provide AppleShare IP services.

Then click the right arrow.

ApplesShare IP Easy Setup

AppleTalk provides compatibility with client applications that only
support AppleTalk. TCP provides compitability with TCP - based client
applications and is faster than AppleTalk. “ou can choose an AppleTalk-
only setup or an AppleTalk and TCP setup.

Click TCP and AppleTalk if you want to set up AppleShare [P so that it
provides services via TCP and AppleTalk.

Click AppleTalk if you want to set up AppleShare |P so that it provides
services via AppleTalk anly.

@ TCP and dppleTalk () dppleTalk

To continue, click the right arrow.

Choose a Hetwork Type
eH

[«1 [o]

If you want to provide AppleShare IP services only over AppleTalk networks, click AppleTalk.

Now skip ahead to “AppleTalk Setup” on page 42.

If you want to provide AppleShare IP services over TCP/IP and AppleTalk networks, click

“TCP/IP and AppleTalk.” Then click the right arrow. The following screen appears.

AppleShare IP Easy Setup

B

Setup Requires TCP Configuration

H|
To set up AppleShare IP for AppleTalk and TCF, the TCP/IP contral
panel must be confiqured. Quit AppleShare |P Easy Setup by choosing
Quit fram the File menu. Configure the TCP/IP cantrol panel before
running AppleShare |P Easy Setup.

For help with setting up TCP, see the AppleShare [P Getting Started
manual or contact your service provider.

Ta quit, select Quit fram the File menu.

Setting Up AppleShare IP 6.0
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You need to set up your TCP/IP control panel before you can provide services over TCP/IP.
See the instructions in “Setting Up TCP/IP” on page 16. Then return to “Using AppleShare IP
Easy Setup” on page 31.

Normal Setup

You should use the Normal setup option if you already have a DNS server on your network.
After you choose Normal, AppleShare IP Easy Setup displays the following screen.

AppleShare IPEasy Setup =———H

Your AppleShare IP Serial Number

ol
Each computer that runs AppleShare IP must have a unique serial
number. Use the serial number that came with yaur software.

Type your serial number:

To cantinue, click the right arrow.

[ [&]

Note: Ifyou're upgrading from a previous version of AppleShare, your previous serial
number is listed.

Type the AppleShare IP 6.0 serial number in the text box, then click the right arrow.

You can find your serial number on the label of your AppleShare IP 6.0 CD holder or on the
sheet you received when purchasing a new serial number. Be sure to store the serial number
in a safe place. You may also want to keep a photocopy of the number in another location.

Important For convenience, the serial number comes printed on a small adhesive label.
Don't put the adhesive label on your AppleShare IP 6.0 CD-ROM disc (or any other CD-ROM
disc or floppy disk). The label could come loose while inside a disk drive and damage the
drive.



AppleShare IP Easy Setup displays the following window.

AppleShare IP Easy Setup

Set Up Servers

Z)

AppleShare |P Easy Setup will set up your computer to:

= Enable users to use AppleShare Client software to connect to the Web
& File Server via AppleTalk and TCP.

» Enable users to use FTP applications to connect to the Web & File
Server via TCP.

® Enable uzers to use Web browsers to wisit your 'Web site.

® [Manage E-mail wia &ppleTalk and TCP.

& Manage printers wia AppleTalk.

Set Up Servers

To continue, click the right arrow.

[«1 [2]

This window summarizes the services that will be set up and the network protocols over

which the services will be available.

Note: If you performed a custom installation, this window will only show information for
the servers that have been installed on this computer.

Click the Set Up Servers button.
When the server setup is complete, click OK.
Click the right arrow.

The following window appears.

AppleShare IP Easy Setup

Easy Setup Starts Servers

Z)

Easy Setup will start the servers that have been set up by default.

If you do not want Eazy Setup to start the servers that have been
installed on your computer, click the Start Servers checkbox so
that the % disappears.

[ Start Servers

To continue, click the right arrow.

[«1 [2]
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By default, AppleShare IP Easy Setup will start the servers that are installed on your
computer. If you don’t want the servers to be started now, click the checkbox so that the X
disappears.

4  Click the right arrow.

If the Start Servers checkbox was checked, AppleShare IP Easy Setup starts the servers and
displays a progress bar. Once the startup process is complete (or if you did not start the
servers) the following window appears.

AppleShare IP Easy Setup

AppleShare IP Setup Complete

‘You can quit AppleShare [P Easy Setup by selecting Quit from the
File menu, or you can click the Start Manager button to start the
&ppleShare |P Manager. The &dppleShare |P Manager provides an
easy way to administer the &ppleShare |P servers.

If you have selected the default selection Start Servers, from the

previous panel, the servers will start up prior to starting the
Manager.

Start Manager

To quit, select Quit from the File menu.

IR

5  Click the Start Manager button.

The AppleShare IP Manager opens. The AppleShare IP Manager provides a convenient
central point for administering the AppleShare IP server programs.

Now skip ahead to “Using AppleShare IP 6.0 for the First Time” on page 45.

Custom Setup

You need to follow the Custom Setup procedure if DNS service is not available on your
network. Custom Setup guides you through the process of setting up MacDNS, a domain
name system (DNS) program that comes with AppleShare IP 6.0.
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After you choose the Custom Setup option, AppleShare IP Easy Setup displays the following
window.

m

AppleShare IP Easy Setup

Your AppleShare IP Serial Number

Z)

Each computer that runs AppleShare I[P must have a unique serial
number. Use the serial number that came with your software.

Type your serial number:

To continue, click the right arrow.

[al [»]

Note: If you're upgrading from a previous version of AppleShare, your previous serial
number is listed.

Type the AppleShare IP 6.0 serial number in the text box, then click the right arrow.

You can find your serial number on the label of your AppleShare IP 6.0 CD holder or on the
sheet you received when purchasing a new serial number. Be sure to store the serial number
in a safe place. You may also want to keep a photocopy of the number in another location.

AppleShare IP Easy Setup displays the following window.

ApplesShare IP Easy Setup

HacDHNS Setup

g

&ppleShare |P Easy Setup will set up MacDNS on this computer and will
azk you for the following information.

® your domain name

» the DNS name of your computer
= the E- mail address of the administrator of this computer

To continue, click the right arrow.

[«1 [o]
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This window summarizes the information that AppleShare IP Easy Setup will ask you to
provide.

2 (Click the right arrow.

The following window appears.

m

AppleShare IP Easy Setup

Your Domain Name

& domain name isa name far @ group of computers. Here are some
examples:

yourdomain.com
yourdomain.edu
yourdomain.goy

Enter your computer's domain name:

yourdomain.edu.

To continue, click the right arrow.

[al [»]

3 Type your organization’s domain name in the text box.

Your organization’s domain name is the name by which the computers on your network are
known to the Domain Name System (DNS) service on your network—for example,
“yourdomain.edu.” Your network administrator (or Internet service provider) should provide
you with this name.

Note: After you've finished setting up AppleShare IP, you can learn more about the Domain
Name System in AppleShare IP Help or in the MacDNS Administrator’s Guide in the MacDNS
folder inside the AppleShare IP 6.0 folder.

4 Click the right arrow button.
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The following window appears.

AppleShare IPEasy Setup =—"—-H

Your Computer Domain Name
aH

The Domain Mame Systern {DNS) associates the name of each computer
with its |P address.

To uze TCP, your computer must have a domain name. You can use
Tetters, numbers, and the dash (- ) character to make a DNS name. |t
must begin with a letter.

Enter your computer's DNS name:

camputername.yourdomain.edu.

To continue, elick the right arrow.

[] [&]

5 Type your computer’s DNS name in the text box.

The DNS (or “host”) name is the name that your DNS server “maps” to your computer’s
unique IP (Internet Protocol) address when communication to or from that address is taking
place. This allows clients to connect to your server by entering an easy-to-remember name in
place of an IP address.

A DNS name cannot contain spaces, punctuation, or special characters that appear when you
press the Option key in combination with another key. You can use a name that matches or is
similar to your computer’s “Computer name” (as defined in the File Sharing control panel).

For example, if your computer’s name is “Mt. Shasta,” its DNS name can be “shasta” or
“mtshasta,” but it cannot be “Mt. Shasta” or “mt.shasta.”

Note: If you will be enabling Windows file sharing service, make the DNS name 12
characters or fewer with no spaces or special characters.

6 Click the right arrow.
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The following window appears.

m

AppleShare IP Easy Setup

Your Administrator's E- mail Address

Z)

MacDMS will send E-mail to anadministrator if it cannot work
properly. Here is an example of an E-mail address:

terry@yourdomain.edu
Mote: Enter the E-mail address now, even if you haven't set up mail

for the administrator yet. Be sure to set it up as soon as possible.

Enter the E-mail address of this computer's administratar:

uzername&yaurdomain.edu.

To continue, elick the right arrow.

[] [&]

7 Type the e-mail address of the person to whom MacDNS or other network administrators
should send mail if a problem arises.

As the server administrator, you'll probably enter your e-mail address here.
8 Click the right arrow button.

The following window appears.

AppleShare IP Easy Setup

Set Up Servers

Z)

AppleShare |P Easy Setup will set up your computer to:

= Enable users to use AppleShare Client software to connect to the Web
& File Server via AppleTalk and TCP.

= Enable users to use FTF applications to connect to the Web & File
Server via TCP.

® Enable users to use Web browsers to visit your Web site.

® [Manage E-mail wia &ppleTalk and TCP.

& Manage printers wia AppleTalk.

® Provide DNS service.
Set Up Servers

To continue, click the right arrow.

[«1 [o]

This window summarizes the services that will be set up and the network protocols over
which the services will be available.

9 (lick the Set Up Servers button.
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When the server setup is complete, click OK.

10 Click the right arrow.

11

The following window appears.

AppleShare IP Easy Setup

Easy Setup Starts Servers

Easy Setup will start the servers that have been set up by default.

If you do not want Eazy Setup to start the servers that have been
installed on your computer, click the Start Servers checkbox so
that the ¥ disappears.

[® start Servers

To continue, click the right arrow.

Z)

[«1 [o]

By default, AppleShare IP Easy Setup will start the servers that are installed on your
computer. If you don’t want the servers to be started now, click the checkbox so that the X

disappears.

Click the right arrow.

If the Start Servers checkbox was checked, AppleShare IP Easy Setup starts the servers and

displays a progress bar. Once the startup process is complete (or if you did not start the

servers) the following window appears.

AppleShare IP Easy Setup

AppleShare IP Setup Complete

‘You can quit AppleShare [P Easy Setup by selecting Quit from the
File menu, or you can click the Start Manager button to start the
AppleShare |P Manager. The &ppleShare |P Manager provides an
easy wal to adrinister the AppleShare P servers.

If you have selected the default selection Start Servers, from the

previous panel, the servers will start up prior to starting the
Manager.

Start Manager

To quit, select Quit fram the File menu.

Setting Up AppleShare IP 6.0
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12

13

14

Click the Start Manager button.

The AppleShare IP Manager opens. The AppleShare IP Manager provides a convenient
central point for administering the AppleShare IP server programs.

Complete your MacDNS setup by adding the required information about each server on your
network to your MacDNS configuration file.

For instructions, see the “MacDNS Administrator’s Guide” in the MacDNS folder inside the
AppleShare IP 6.0 folder on your startup disk.

Note: You will not be able to use your AppleShare IP services until you configure your DNS
file and complete the remaining tasks in this chapter.

After you've finished updating your MacDNS configuration file, go to “Using
AppleShare IP 6.0 for the First Time” on page 45.

AppleTalk Setup

You should choose AppleTalk if you plan to provide AppleShare IP services only over an
AppleTalk network. After you choose AppleTalk, AppleShare IP Easy Setup displays the
following window.

m

AppleShare IP Easy Setup

Your AppleShare IP Serial Number

g

Each computer that runs AppleShare I[P must have a unique serial
number. Use the serial number that came with your software.

Type your serial number:

To continue, elick the right arrow.

[al [&]

Note: If you're upgrading from a previous version of AppleShare, your previous serial
number is listed.

Type the AppleShare IP 6.0 serial number in the text box, then click the right arrow.

You can find your serial number on the label of your AppleShare IP 6.0 CD holder or on the
sheet you received when purchasing a new serial number. Be sure to store the serial number
in a safe place. You may also want to keep a photocopy of the number in another location.



AppleShare IP Easy Setup displays the following window.

AppleShare IP Easy Setup

Set Up Servers

Z)

AppleShare |P Easy Setup will set up your computer to:

= Enable users to use AppleShare Client software to connect to the Web
& File Server via dppleTalk.

= [Manage E-mail wia &ppleTalk.

» [Manage printers via &ppleTalk.

TCP services will not be enabled.

Set Up Servers

To continue, click the right arrow.

[«1 [2]

This window summarizes the services that will be set up and the network protocol over

which the services will be available.

Note: If you performed a custom installation, this window will only show information for
the servers that have been installed on this computer.

Click the Set Up Servers button.
When the server setup is complete, click OK.
Click the right arrow.

The following window appears.

AppleShare IP Easy Setup

Easy Setup Starts Servers

Z)

Easy Setup will start the servers that have been set up by default.

If you do not want Eazy Setup to start the servers that have been
installed on your computer, click the Start Servers checkbox so
that the % disappears.

[ Start Servers

To continue, click the right arrow.

[«1 [2]
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By default, AppleShare IP Easy Setup will start the servers that are installed on your
computer. If you don’t want the servers to be started now, click the checkbox so that the X
disappears.

4  Click the right arrow.

If the Start Servers checkbox was checked, AppleShare IP Easy Setup starts the servers and
displays a progress bar. Once the startup process is complete (or if you did not start the
servers) the following window appears.

AppleShare IP Easy Setup

AppleShare IP Setup Complete

‘You can quit AppleShare [P Easy Setup by selecting Quit from the
File menu, or you can click the Start Manager button to start the
&ppleShare |P Manager. The &dppleShare |P Manager provides an
easy way to administer the &ppleShare |P servers.

If you have selected the default selection Start Servers, from the

previous panel, the servers will start up prior to starting the
Manager.

Start Manager

To quit, select Quit from the File menu.

IR

5  Click the Start Manager button.

The AppleShare IP Manager opens. The AppleShare IP Manager provides a convenient
central point for administering the AppleShare IP server programs.

Go to “Using AppleShare IP 6.0 for the First Time” on page 45.
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Using AppleShare IP 6.0 for the First Time

If you clicked the Start Manager button at the conclusion of the AppleShare IP Easy Setup
program, the AppleShare IP Manager window appears. (You can also start the AppleShare IP
Manager by double-clicking its icon in the AppleShare IP 6.0 folder.)

O AppleShare IP Manager o——"x= o
Adrmin Status
Rt ‘web & File Admin: Not Running
@‘ ‘web & File Server: Running
‘weh: Enabled

AppleShare via TCP: Enabled
FTF: Enabled
‘Windows File Sharing: Disabled

Mail Admin: Mot Running
i Mail Serwver: Running
IMAP: Enabled

POP: Enabled
SMTP: Enabled

Print Admin: Not Running
Q Print Server: Running

The AppleShare IP Manager window displays status information about the servers that are
installed on your computer and provides an easy way to open each of the server
administration programs. To open an administration program, click a button along the left
side of the window, or choose one of the “open program” commands—for example, Open
Web & File Admin—from the File menu.

In this section, you'll use the AppleShare IP Manager to access the administration programs
and perform the following final setup tasks:

register a user

set up file sharing and FTP service by creating a share point

set up Web service by setting access privileges to the Web Folder
enable Windows file sharing (if you have Windows clients)

set up mail service by enabling mail for registered users

set up print service by creating a print queue

Note: This section takes you through the first-time setup tasks that are required to provide
AppleShare IP services to your users. In some cases, more detailed information is available in
AppleShare IP Help. After you complete the instructions in this manual, you may want to
review these tasks in AppleShare IP Help.
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Registering a User for the First Time

If this is the first time you've used a version of AppleShare on your computer, you need to
register the users who will need access to your servers. Each registered user has a name and
(optionally) a password that authenticates the user when he or she logs on.

In this section, you'll create just one user. After you've completed this chapter, you should
refer to the instructions in AppleShare IP Help to register your remaining users, and learn
about creating groups, enabling guest access, and related tasks.

If you upgraded from a previous version of AppleShare or Macintosh file sharing, the users
and groups you've already created are still available. You can skip this section and go to
“Setting Up File Sharing for the First Time” on page 49.

Note: You can create registered users through the Web & File Admin program or the Mail
Admin program. This chapter shows you how to register users through the Web & File Admin
program.

To register a user through the Web & File Admin program, follow these steps:

1 Inthe AppleShare IP Manager window, click the Open Web & File Admin button.
Note: You can open any of the server administration programs in three ways:
n Click one of the Open Admin buttons in the AppleShare IP Manager window.

» Choose one of the Open Admin commands from the File menu in the AppleShare IP
Manager program.

= Double-click the administration program’s icon in the appropriate folder in the
AppleShare IP 6.0 folder.

The Administer Web & File Server dialog box appears, with the Owner Name that you
entered in the File Sharing control panel already entered in the Administrator Name field.

Administer Web & File Server

Administrator Name: |Steph Koester

Password: [|

(o) (5]

2 Type your password in the Password text box.
Type the Owner Password that you entered in the File Sharing control panel.

3 Click OK.
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The AppleShare IP Manager opens the Web & File Admin program, which displays the Web &
File Server Activity window.

0 =————""—"—"'eb &File Server Activin =————————— 8
Status: Mot Running Current User Activity: | I —
Mame: myserver Set Maximum: Min =m=l Max
Connected Users: 0 Guest Access: File: On FTP: Off
99\ ‘Web: On Windows: Off
({day hr:min} {day hr:min}
Connected User Connection Type Connected For Idle For

ID

S

4 Choose Show Users & Groups List from the Web & File Admin program’s Users menu.

The Users & Groups List appears.

Users & Groups List —=———=HI1B

Mame Kind Last Log On
& Guest Guest 1= |
[ Mail Administrator Disabled User Newer
3 steph Koester sdministrator  S/26/98, 12:46 PM
[~
2 Users, 0 Groups | 4 |M | »]

5 Click the New User button at the top left side of the window to create a new user.

A new, untitled user is added to the Users & Groups List, and a User window appears.

O =————User: untitled | =——=H

[ General |

Harme: |unt1't1ed 1 | Password: |

Inter net Alias: | |

[ Enable user to administer the server
[ Program Tinking

User maylogon [] Disablelogon asof:| S/ 6/93 @

User may change password
[ Require new password on next 1og on

(Revert) (Save )
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6 Select the contents of the Name text box and type your new user’s name.

The name can be up to 31 characters long. For example, type

Ethan Switzer

The name is not case-sensitive, so the user can type

Ethan Switzer

or

ethan switzer
when connecting (or “logging on”) to an AppleShare IP server.

The name is also the basis of the client’s e-mail address, and is used by the Mail Server to
identify the user when his or her client e-mail application logs on to the Mail Server.

Important If this user will be connecting to the Web & File Server for Windows file sharing
services, enter the same logon name that the user enters to log on to his or her Windows
computer.

If you want to assign this user a password, type it in the Password text box.

Assigning a password is highly recommended, and required for some client e-mail and FTP
applications. A password can be up to eight characters long. For each character that you type,
abullet appears, so it is important to record what you type. (Be sure to note whether the
Caps Lock key is depressed.)

For increased security, use eight character passwords or include a combination of letters and
numbers. Passwords are case-sensitive, so users must enter their password exactly as you
type it before they can connect to an AppleShare IP server.

If this user will be using the Mail Server, make the password include only letters and
numbers, and avoid using spaces and special characters. (Some client mail applications do
not allow users to type special characters or spaces when they enter passwords.)

Important If this user will be connecting to the Web & File Server for Windows file sharing
services, enter the same logon password that the user enters to log on to his or her Windows
computer.

If you want to allow this user to use an Internet alias when logging on to an AppleShare IP
server, enter a name in the Internet Alias text box.

You need to assign an alias if this user will be using mail or FTP services and the user name
contains spaces or special characters. The alias should consist only of numbers and
unaccented uppercase and lowercase letters. For example,

ethanl



10

1

The user can use this alias to connect to the Web & File Server. The Mail Server uses this alias
to identify the user when the user’s client mail application logs on to the Mail Server over
TCP.

Note: If the user’s name does not include spaces or special characters, he or she can use
mail or FTP services without having an Internet alias.

Click Save.

The new user is created and appears in the Users & Groups List window.

Note: If your name (as owner of the computer) includes spaces or special characters, you
should assign yourself an Internet alias now. Double-click your name in the Users & Groups
List window, enter an Internet alias using the guidelines in step 8, then click Save. As the
administrator, you can use your Internet alias to log on to administer any AppleShare IP
servers for which you are the administrator.

Complete the rest of this chapter, then go to the Users & Groups section in AppleShare IP
Help to register your remaining users.

You can repeat steps 5 through 9 above to register all of your users now. However, many
options and tips for quickly and efficiently setting up large numbers of users and groups are
described in AppleShare IP Help.

Setting Up File Sharing for the First Time

Before clients can use AppleShare or Windows file sharing or FTP services, you need to
specify a disk, CD-ROM disc, or folder as a share point and assign access privileges to it. A
share point is a disk, CD-ROM disc, or folder that is made available to users on a network.

Important If you're planning to enable FTP or Windows file sharing service, make sure the
names of any shared hard disks, folders, or files include only letters and numbers and contain
12 characters or fewer. Avoid using spaces and special characters that are produced in
combination with the Option key. If necessary, you should change the names of any share
points in the Finder before continuing with this task.

Note: If you've upgraded from AppleShare 3 or 4, or AppleShare IP 5, the folders and hard
disks that you shared before you installed AppleShare IP 6.0 are still being shared. You do not
need to create a new share point, and can skip ahead to “Setting Up Web Service for the First
Time” on page 52. If you will be providing Windows file sharing service, however, make sure
the names of your previous share points have 12 characters or fewer and contain no special
characters or spaces.

To create a share point, follow these steps:

Open the Web & File Admin program, if it’s not already open.
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Click the “Open Web & File Admin” button in the AppleShare IP Manager. Enter your name
and password in the Administer Web & File Server dialog box, then click OK.

The Web & File Admin program opens and the Web & File Server Activity window appears.

2  If AppleShare IP Easy Setup didn’t start the Web & File Server for you, choose Start Web &
File Server from the Server menu.

A dialog box indicates that the Web & File Server is starting up. When the status line in the
upper-left corner of the Web & File Server Activity window indicates that the Web & File
Server is running, go to step 3.

3 Choose Show Disks & Share Points from the Server menu.

The Disks & Share Points window appears.

0O =—-_—————Disks &Share Points =—"———HI18
Show: ® Disks
B o {3 Share Points
Mame Kind
P ¢= HardDisk disk =
[l | o

The names of your hard disks and any CD-ROM discs appear in the Disks & Share Points
window.

4  Click the triangle to the left of an item to display its contents.

O=——"—————Disks &Shareftinls ="—————— =]
Show: @ Disks
B & ) Share Points
Name Kind
=7 (=3 HardDisk disk |~ |
I ﬁ Apple Extras folder =
b O applestare IP 6.0 folder
I ﬁ AppleShare |P Mail Folder folder
[ ﬁ APPLICATIONS folder
I Ei Aazistants folder
b [ Coient Software 3.8 folder =
ey
LRI 1» ]2

5 Select the disk, CD-ROM disc, or folder that you wish to share.
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If you select a disk, every folder on it (except the System Folder on a startup disk) will be
available to users who log on to the Web & File Server. If you select a folder, everything in the
folder (including enclosed folders and their contents) will be shared.

Note: 1f you will be providing Windows file sharing service, the name of your share point
should have 12 characters or fewer and contain no special characters or spaces.

Click the Privileges button (or double-click the item you want to share).

The Privileges window for the selected disk or folder appears.

O =]

Privileges: Client Software 3.8

Select Privileges

@ Use enclosing item's privileges
() Set privileges for this item
(2} Make this a share point and set privileges

Show Users & Groups List

Owner: | Steph Koester 5‘3§

User /Group:

Everyone:

[(E

Make all enclozed folders Tike this one

2

] Can't move, rename, or delete this folder

Revert Save

i

Click the “Make this a share point and set privileges ” button.

All of the folders that a share point contains are also shared. For security reasons, it’s often
better to share folders instead of entire disks.

Choose the appropriate access privileges for the Everyone category.

As the administrator of this computer, you are the default owner of all volumes and the
folders they contain. By default the owner has Read and Write access privileges (meaning you
can open or make changes to shared items).

“Everyone” includes everyone listed in the Users & Groups List (including Guest), so select
the access privilege that you want any registered user or guest to have when accessing this
share point. Following are brief descriptions of each privilege:

n Read & Write: Allows a user to see, open, and copy files and make changes to the
contents of the share point (including creating, deleting, moving, and modifying files).

» Read Only: Allows a user to see, open, and copy files.

n  Write Only: Allows a user to change the contents of the share point by moving files and
folders in or to it, but not to see files or folders. A folder to which the Write Only privilege
is assigned is also known as a drop box.
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» None: The user has no access to the folder or files of this share point.

Note: Later you may want to further restrict access to this share point by selecting a user or
group to have different privileges, or by setting different privileges for certain folders. You
can learn more about access privileges and related topics in the Web & File section of
AppleShare IP Help.

Click Save.

In the Disks & Share Points window, the icon for the disk, CD-ROM disc, or folder you've
selected shows a wire underneath or to the side to indicate that the item is shared.

Now when anyone in the Users & Groups list logs on to the Web & File Server via TCP/IP or
AppleTalk, he or she will be able to access this share point to the extent of the privilege
you've set.

Note: To set explicit access privileges for any folders inside this share point, see the Web &
File section in AppleShare IP Help after completing the instructions in this manual.

Repeat steps 5 through 9 to create all the share points you wish to create.

You can also wait to create your remaining share points until after completing the
instructions in this manual. If you decide to wait, see the Web & File section in AppleShare IP
Help for more information on creating share points and setting access privileges.

Close the Disks & Share Points window.

You've completed your file sharing setup. To set up Web service, go to the next section.

Setting Up Web Service for the First Time

Web service and guest access to Web services is enabled by default. However, you need to
define the access privileges you want users to have to the Web Folder. In order to make sure
no one alters the contents of your Web site, you should assign Read Only access privileges to
the Everyone category for the Web Folder share point.

To set access privileges to the Web Folder, follow these steps:
Open the Web & File Admin program, if it’s not already open.

Click the “Open Web & File Admin” program button in the AppleShare IP Manager. Enter
your name and password in the Administer Web & File Server dialog box, then click OK.

The Web & File Admin program opens and the Web & File Server Activity window appears.

If AppleShare IP Easy Setup didn’t start the Web & File Server for you, choose Start Web &
File Server from the Server menu.

A dialog box indicates that the Web & File Server is starting up. When the status line in the
upper-left corner of the Web & File Server Activity window indicates that the Web & File
Server is running, go to step 3.



3 Choose Show Disks & Share Points from the Server menu.
The Disks & Share Points window appears.
4  Select the Web Folder at the root level of your AppleShare IP server’s hard disk.

O Disks & Share Points =——-—————[0H
i . Disks
= Show: @
@ ) Share Points
Name Kind
I ﬁ Internet folder -
b [ tMac0S Read Me Files folder
I ﬁ My Personal wWeb Site faldar
I ﬁ Stationery folder
b O utitities folder
b W web Folder folder =
13 § ‘web Pages folder ~
oA i) 1» |2

To see the contents of an item, click the triangle to its left.
5 Click the Privileges button (or double-click the Web Folder).

The Privileges window for the Web Folder appears.

[0 ==—— privileges: Web Folder =—i—"—8

Select Privileges
@ Use enclosing item’s privileges
(2} Set privileges for this item
() Make this a share point and set privileges

Show Users & Groups List
Owner: @ Steph Koester 6"?

User /Group:

qiKiK

Everyone:

Make all enclosed folders like this one

[ can‘t move, rename, or delete this folder

G

6 Click the “Make this a share point and set privileges” button.

All of the folders that a share point contains are also shared. For security reasons, it’s often
better to share folders instead of entire disks.

7 Choose Read Only from the Everyone pop-up menu, and make sure Read & Write is selected
for the owner category.
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“Everyone” includes everyone listed in the Users & Groups List (including Guest). Choosing
Read Only means any registered user or guest can view the contents of your Web Folder, but
they cannot change its contents. For descriptions of each privilege, see “Setting Up File
Sharing for the First Time” on page 49.

As the administrator of this computer, you are the default owner of all volumes and the
folders they contain. By default the owner has Read and Write access privileges (meaning you
can open or make changes to shared items).

Click Save.
Your changes are saved.

If you have a Mac OS—only network, skip ahead to “Setting Up the Mail Server for the First
Time” on page 56. If there are any Windows clients on your network, continue to the next
section.

Setting Up Windows File Sharing for the First Time

If you want any Windows or Windows NT computers to connect to your AppleShare IP server,
you need to configure your Web & File Server for Windows file sharing and make sure the
appropriate networking software is installed on your Windows clients.

In this section, you'll learn how to set up a network in which all your Windows clients are in
the same subnet as your AppleShare IP Web & File Server. Your network administrator should
be able to tell you if they are in the same subnet.

If your Windows clients are not on the same subnet as the Web & File Server, you should
review this section, complete the instructions in the remainder of this manual, then set up
your network for AppleShare IP Windows file sharing following the instructions in the
Windows File Sharing section in the Web & File section in AppleShare IP Help.

Note: Windows file sharing can only be provided over TCP/IP. If you have not already set up
your TCP/IP control panel, follow the instructions in “Setting Up TCP/IP” on page 16 before
continuing with this section.

To set up Windows file sharing when your Windows clients are in the same subnet as the Web
& File Server, follow these steps:

Open the Web & File Admin program, if it’s not already open.

Click the “Open Web & File Admin” program button in the AppleShare IP Manager. Enter
your name and password in the Administer Web & File Server dialog box, then click OK.

The Web & File Admin program opens and the Web & File Server Activity window appears.
Choose Web & File Server Settings from the Server menu.

The Web & File Server Settings window appears.

3 Choose Windows File Sharing from the Web & File Server Settings pop-up menu.



The Windows File Sharing panel appears.

O ==——=Wweb &File Server Settings =——H

[ Windows File Sharing v |

[ Enabile 'indows File Sharing (SMB)

Server Name: [muyserver |

workgroup: [WORKGROUP |

Description: [AppleSharelP |

[ Enable "I NS Registration

WINS Server: | |

G

Click the “Enable Windows File Sharing” checkbox so that an X appears.
Windows File Sharing services become available immediately.
If necessary, enter a new name for the Web & File Server in the Server Name text field.

By default, the Web & File Server assigns the AppleShare IP server’s unqualified DNS name
(the first name before the first dot) as the Windows file sharing server name. (For example,
an AppleShare IP server with the DNS name “myserver.company.com” has the unqualified
Windows server name “myserver.”) Apple recommends you use the name provided because
it makes it easier for some clients to connect to the Web & File Server.

If you decide to change the server name, it must be a valid Windows host name with 15
characters or fewer and no special characters or punctuation (such as A[]:+" | <>=;*? or
space).

Type the workgroup name for your server in the Workgroup text field.

The workgroup name is the name Windows computers use to describe their local group of
computers on the network. Consult your Windows network administrator for the correct
name of the workgroup in which your Web & File Server is located.

If you like, type a description for the server in the Description text box.

You can enter up to 48 characters. Users see this information in their Network
Neighborhood. You may want to enter your name and phone number so users know whom
to contact for information.

Click Save.

Windows file sharing service will become available after you restart the Web & File Server.
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Close the Web & File Server settings dialog box.
Restart the Web & File Server.

If the server is running, choose Stop Web & File Server from the Server menu. After the
server stops, choose Start Web & File Server from the Server menu.

Make sure you've created at least one share point with a valid Windows folder name.

Valid Windows folder names have 12 characters or fewer, and no special characters or
punctuation. For instructions on creating a share point, see “Setting Up File Sharing for the
First Time” on page 49.

Make sure the following networking software is installed and configured on each of your
Windows clients:

n  On your Windows 95 clients, install the “Client for Microsoft Networks,” “TCE/IP
Protocol,” and “File and Print Sharing for Microsoft Networks” software.

n  On your Windows NT clients, install the “Workstation” and “TCP/IP Protocol” software.

For instructions on installing or configuring this software, see your Windows software
documentation.

On a Windows client computer, connect to the Web & File Server using the Network
Neighborhood.

Open the Network Neighborhood window to see the AppleShare IP server. It may take up to
an hour or more before the Web & File Server appears. Double-click the icon to connect to
the server.

IE_EI_ Metwork Neighborhood [_ (O] =]
File Edit Yiew Help
Mame | Comment

Entire Metwork Entire Metwork
i AppleSharelP

|2 abjectis) 4

Note: Client users in a different workgroup from the Web & File Server need to double-click
the Entire Network icon, find and double-click the correct workgroup icon, and double-click
the Web & File Server icon.

Now go to the next section to set up the Mail Server.

Setting Up the Mail Server for the First Time

If you want your users to be able to send and receive e-mail messages via TCP or AppleTalk,
you need to enable mail service for each user.



If you're upgrading from a previous version of the AppleShare Mail Server, your users and
groups mail settings are still available. You can skip this section and go to “Setting Up the
Print Server for the First Time” on page 59.

Note: 1f you have a large number of users for whom you want to enable mail services, you
can create a spreadsheet with the necessary information and import it. For instructions, see
the Users & Groups section of AppleShare IP Help after completing the remaining
instructions in this maual.

To enable mail for registered users, follow these steps:

Open the Mail Admin program by clicking the Open Mail Admin button in the AppleShare IP
Manager window.

Enter your name and password in the Administer Mail Server dialog box. Then click OK.

The Mail Admin program starts up and displays the Mail Server Activity window.

Mail Server Activity ————=—xH

= Server Status: Running
|

Mail Storage

Wolume: HardDisk
Size: 520 K

Number of Messages: 0

Click the Users & Groups List button (or choose Show Users & Groups List from the Server
menu).

The Users & Groups List window appears.

In the Users & Groups List window, double-click the name of a user for whom you want to
enable mail.

The User window for the user appears.

Note: If you're installing AppleShare IP for the first time and following the instructions in
this manual, you may only have one registered user, besides yourself, in the Users & Groups
List. After you've created your remaining users, don't forget to enable mail for them too.

If the user’s name contains spaces or special characters, make sure there is a name in the
Internet Alias text box.

If the user’s name contains spaces or special characters, the Mail Server uses the Internet
alias (if one is provided) to identify users who log on over TCP. For information on entering a
valid Internet alias, see “Registering a User for the First Time” on page 40.
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5 Choose Mail Settings from the pop-up menu in the User window.

[0 = User:Ethan Switzer=——"—8

[ Mail Settings |

E- mail Address: ethan1®mailcompanycom

Account: @ None () Enable () Forward

The mail server does not accept mail for
s this user.

=]

The user’s e-mail address appears below the pop-up menu. If the user was given an Internet
alias in the General panel, the Mail Server automatically uses the alias for the first portion of
the user’s e-mail address.

Important The user’s e-mail address is the address that other users should use to send
mail to this user. Be sure to tell this user to enter this e-mail address as his or her return
address when he or she sets up his or her client mail application.

Note: If the e-mail address shows the user’s Internet alias followed by the Mail Server’s IP
address (for example, ethan1(@172.16.54.2), then DNS service is not set up on your
network. You need to set up DNS service if your network is connected to the Internet or if
you want your users to be able to send mail to domain names instead of IP addresses. To set
up MacDNS, an implementation of DNS service that comes with AppleShare IP, follow the
custom setup instructions in “Using AppleShare IP Easy Setup” on page 31.

6 Click the Enable button.



When mail is enabled, the user can connect to this computer for mail service. The User
window changes to show the user’s mail account name below the enable button.

[0 =-————=User: Ethan Switzer =—"~"—H

[ Mail Settings |

E-mail Address: mailcompanycom
Account: ) Mone @ Enable (2 Forward
Account Name: ethan i

Select the access method for the user's mail account:
() POP only

() IMAP only

@ Both POP and IMaP

CGe=J

Important Be sure to tell this user to enter this account name and the password you
assigned in the General panel when he or she sets up his or her log-on information in a client
mail application.

Click Save.

Mail is enabled for this user. He or she can configure and then use any client e-mail
application that supports both the POP and IMAP protocols. For more information about
these protocols or other mail settings, see the Mail Server section of AppleShare IP Help after
you complete the remaining instructions in this manual.

If the Mail Server is not already running, choose Start Mail Server from the Mail Admin
program’s Server menu.

Important If you install and run the AppleShare IP Mail Server on more than one computer
(which would require purchasing an additional copy of AppleShare IP), you need to
coordinate the flow of mail among all of the computers that provide mail service. Depending
on how your network is configured, you may also need to set up the Mail Server so that it
forwards or relays mail to other servers. Be sure to review how mail service and mail
forwarding work in the Mail Server section of AppleShare IP Help after you've completed this
chapter. You should also review your license agreement.

The Mail Server is now set up. Go to the next section to set up the Print Server.

Setting Up the Print Server for the First Time

You need to create at least one print queue with one printer attached before you can use the
Print Server. A queue is a list of print jobs that are being stored on the Print Server until the
server sends the jobs to one of the attached printers.
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You can attach printers on each network connection type (AppleTalk or TCP/IP) to the same
or different queues. To get started, this section will only describe setting up an AppleTalk
printer queue. For instructions on connecting a printer over TCP/IP, see the Print Server
section of AppleShare IP Help after you complete the remaining instructions in this manual.

To create a queue and attach a printer to it, follow these steps:

1 Make sure that any printers you'd like to attach to your print queue are connected to the
network and turned on.

To check if a printer is connected correctly over AppleTalk, see if it is visible in the Chooser.

2 Open the Print Admin program by clicking the Open Print Admin button in the AppleShare
IP Manager window.

Enter your name and password in the Administer Print Server dialog box. Then click OK.

The Print Admin program starts up and the Print Server Activity window appears.

Print Server Activity=—————H B
Server Status: Running
m
= |EH{ER R ES
Quewe Hame Jobs  Printers  Status
-
[~
00ueues, 1 Printer |4 |_ﬂ| | »]

3 If the Print Server is not already running, choose Start Print Server from the Server menu.
The Server Status in the activity window changes to Running.

4 (Click the New Queue button at the top left of the Print Server Activity window.
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The New Queue dialog box appears.

New Queue: Untitled Queue

General %/ Attached Printers \/ Security

Queue Name: [Untitled Queue

[ Enable Queuing — [ Enable Printing

[ Enable &ppleTalk (P4P) B Print job while quening
[ Enable TCRAIP (LPR)

e Adwertise color printing Print Cover Page
B &llow binary data @ Nane

(2 Befare each job
() After each job

Cancel I Save "

5 Type a name for the queue in the Queue Name text box.

The name identifies the print queue in the Print Server Activity window. If this will be an
AppleTalk print queue, this is also the name that appears in the user’s Chooser.

The name can be up to 31 characters long and can contain any character except a colon (:),
Option-X (=), or an equal sign (=). The name cannot begin with a space character, and it
must be unique within its zone (it cannot have the same name as another printer or queue in
the same zone).

Note: If you decide to make the attached printer not visible in the Chooser (as described in
step 9), the queue name can be the same as the attached printer name.

Setting Up AppleShare IP 6.0 61



6 Click the Attached Printers tab.

New Queue: Untitled Queue
General \/ Attached Printers\/ Security
= Name Hold Hide
EE =
[+~
Protocol:[ AppleTalk 3}
Zone: [ East Wing T
Alex |~
Aphrodite {6300 =
Art Pro 630
Bailey's Pawprints -
Cancel I Save "

Alist of the printers that are available in the chosen AppleTalk zone appears.

7 Ifyou want to attach a printer that’s located in a different AppleTalk zone, choose a different
zone from the Zone pop-up menu.
If your network does not have any zones, the pop-up menu is not available.

8 Toattach a printer, select the printer, then click the Attach Printer button to the left of the
printer list.

The attached printer and the AppleTalk zone in which it’s located appear in the Attached
Printers list.
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10

If you do not want users to be able to print directly on this printer, click the Hide checkbox
to the right of the printer so that a checkmark appears.

=—————=— New Queue: Untitled Queve =""r————

General %,/ Attached Printers\/ Security

MName Hold Hide
#phrodite {6307 in East Wing O B |~

Protocol:[ AppleTalk

Zone: [ East Wing
Alex

Art Pro 630
Bailey's Pawprints
Beat L&

Cancel I Save “

When the Hide checkbox is not checked, both the queue and the individual printer appear in
the Chooser, and users can choose either one.

Being able to print directly on a printer may be useful for applications that allow the feeding
of individual sheets of paper, such as envelopes, to the printer.
Click Save.

The queue appears in the Print Server Activity window. When the status line of the queue
indicates that it is operating normally, the queue is ready to use.

Print Server Activity=—————FHH
Server Status: Running
3
E3|ES | ES | ES| S
Queue Hame Jobs  Printers Status
= My Main Queue 1] 1 The queue iz operating normally. [
Q Aphrodite (6303 in East Wing status: configuring.
[=|
1 Queue, 1 Printer | 4[] 2B
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If you want to attach a printer that’s connected to your TCP/IP network or learn about other
Print Server options, see the Print Server section in AppleShare IP Help after you complete
the instructions in this manual.

The Print Server is now set up. Go to the next section for information on how to get client
users ready to use AppleShare IP 6.0.

Getting Users Ready

Now that you've finished setting up your AppleShare IP 6.0 services, Apple strongly
recommends that you upgrade your client Macintosh computers to Mac OS 8.1 or later and
install the AppleShare Client 3.8 software. These upgrades are required for users to take full
advantage of the features of AppleShare IP 6.0. At a minimum, client users need to have
system software 7.6 or later and AppleShare Client 3.8 installed.

Note: Windows clients do not need to do any additional installation or setup beyond what is
described in “Setting Up Windows File Sharing for the First Time” on page 54. For
descriptions of services available to Windows clients, see “Windows Client Services” on

page 60.

Upgrading Mac OS Clients

You can make the AppleShare Client 3.8 Installer available to the Macintosh client users via
the Web & File Server.

To upgrade the client software, follow these steps:

Make sure your client computers have system software 7.6 or later and Open Transport 1.1.2
or later installed. If possible, install Mac OS 8.1 on all Mac OS client computers.

See an Apple-authorized dealer for information about purchasing this software, or visit The
Apple Store Web site at

http://store.apple.com
Open the Web & File Admin program, if it’s not already open.

Open the AppleShare IP Manager and click the “Open Web & File Admin” button. Enter your
name and password in the dialog box that appears, then click OK.

If the Web & File Server is not running, choose Start Web & File Server from the Server
menu.

To see if the Web & File Server is running, check the Status area in the AppleShare IP
Manager window.

Make the AppleShare Client 3.8 folder a share point, and assign at least Read Only access
privileges to the Everyone category.



For instructions on how to share this folder and assign privileges, follow the instructions
under “Setting Up File Sharing for the First Time” on page 49.

Provide users with the information they need to find the shared folder using the Chooser.

Users should open the Chooser and select the AppleShare icon, the zone in which the Web &
File Server is located, and the name of the server and volume they need to access.

The server name is the computer name that you entered in the File Sharing control panel.
The server zone is the zone you selected in the AppleTalk control panel. The volume they
need to access is the shared AppleShare Client 3.8 folder.

Tell users to open the AppleShare Client 3.8 folder and install as instructed.

Users should refer to the “AppleShare IP Client 3.8 Read Me” file (in the AppleShare Client
3.8 folder) for instructions on how to install and use the client software. The read me file also
has additional information about interpreting access privileges.

Mac OS Client Services

After Mac OS clients have upgraded their software, they can use AppleShare IP services as
follows.

Using Web & File Services

To use AppleShare file sharing services, client users select the AppleShare icon in the
Chooser, then connect to the Web & File Server and access shared files (or volumes).

To use FTP services, client users need to enter an FTP address (for example, “ftp://
myserver.company.com”) in a client application that supports FTP. The industry-standard
Web browsers that come with Mac OS 8.1—Microsoft Internet Explorer and Netscape
Navigator=—both support FTP.

To connect to your Web site, client users enter the Web server’s universal resource locator
(URL) into any industry-standard Web browser. The URL is “http://<<DNS name>,” for
example, “myserver.company.com.” Alternatively, users can type in the IP address for the
AppleShare IP Web & File Server, for example, 172.33.156.88.

Using Mail Service

To connect to the Mail Server, Macintosh users can use any Internet client mail application
that supports SMTP and POP or IMAP protocols. The client’s e-mail program need to be
configured with the account name, password, and e-mail address you assigned them in the
Mail Admin program. See “Setting Up the Mail Server for the First Time” on page 56.

Using Print Service

To use the Print Server over AppleTalk, client users need to have version 7 or 8 of the
LaserWriter printer driver installed. For TCP/IP printing, clients need to have LaserWriter 8.5.1
or later installed.
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Ideally, you should upgrade all Macintosh clients on your network to use the same version of
the printer driver. The Print Server also accepts connections from users of Apple IIGS
computers and Newton devices.

To check the version number of the printer driver, select the LaserWriter icon in the
Extensions folder (inside the System Folder) and choose Get Info from the File menu.

Windows Client Services

AppleShare IP 6.0 provides file sharing (via AFP and SMB), FTP, Web, mail, and print service
for Windows 95 and Windows NT users.

Note: As the AppleShare IP administrator, you should be aware of the differences between
administering for Windows and Mac OS users to avoid file sharing problems. For Windows
file sharing and naming guidelines, see the Windows File Sharing section in the Web & File
Server section of AppleShare IP Help.

Windows File Sharing Service

Windows 95 and Windows NT computers have built-in support for the Windows file sharing
protocol, SMB, supported by AppleShare IP 6.0.

Web and FTP Service

Windows 3.0 and later, Windows 95, and Windows NT users can connect to the Web & File
Server via any standard Web browser or FTP application.

Mail Service

Windows 3.0 and later, Windows 95, and Windows NT users can use the Mail Server if they
have installed a POP or IMAP and SMTP-compliant client mail application.

Print Service

Windows 95 users can use the Print Server if they have installed an AppleTalk-compatible
printer driver or an LPR-compatible TCP/AP print driver. (Windows NT computers have built-
in LPR support.)

Windows 95 users can print using any third-party AppleTalk-compatible print software, or
TCP-compatible printers that support the LPD/LPR protocol.

Note: The Print Server does not support secure printing for Windows clients.

For more information about administering AppleShare IP 6.0 services or troubleshooting
problems that may arise while using the software, see AppleShare IP Help.



APPENDIX

Changing the Startup Disk

The AppleShare IP 6.0 servers use several files located in the System Folder of your startup
disk. If you change your startup disk after you install any of the AppleShare IP server
programs, you need to install AppleShare IP 6.0 on the new startup disk and copy certain
files and folders from the old startup disk to the new startup disk.

This appendix provides instructions for two scenarios:
» adding a new disk, making it the startup disk, and keeping the old disk
» replacing the startup disk

Depending on whether you add or replace a startup disk and which AppleShare IP servers
your computer is running, you may skip some of the steps in this appendix.

To change the startup disk, follow these steps:

Shut down your computer and connect the hard disk you want to use as the startup disk.
See the manual that came with your computer for detailed instructions.

Restart your computer.

Make sure that the new hard disk has a name that is different from the startup disk.

Install Mac OS 8.1 (which includes Open Transport 1.3) and AppleShare IP software on the
new hard disk.

For instructions, see “Installing AppleShare IP 6.0 Software” on page 25.

Drag a copy of the Users & Groups Data File from the Preferences folder inside the System

Folder on your startup disk to the Preferences folder inside the System Folder on the new
hard disk.

If your computer is being used to run the Web & File Server, drag a copy of the AppleShare
IP Preferences folder from the Preferences folder inside the System Folder on your startup
disk to the Preferences folder inside the System Folder on the new hard disk.

If you are replacing your startup disk and if your computer is being used to provide Web
service, drag a copy of the current Web Folder from your startup disk to the new hard disk.

67



68  Appendix

10

11

12

13

14

15

This step is not necessary if you are adding a disk that will be the new startup disk and you
plan to use both hard disks.

If you are replacing your startup disk and if your computer is being used to share data, use
the Web & File Admin program’s Duplicate Folder command to copy shared folders from the
startup disk to the new hard disk.

Do not use the Finder to copy the folders because the folders’ access privileges will not be
retained. For information about using the Duplicate Folder command, see the Web & File
Server section of AppleShare IP Help.

If you are replacing your startup disk and if your computer is being used to run the Mail
Server, drag a copy of the AppleShare IP Mail Folder from your startup disk to the new hard
disk.

This step is not necessary if the AppleShare IP Mail Folder is not currently located on your
startup disk.

If you are replacing your startup disk and if your computer is being used to run the Print
Server, drag a copy the Print Server Preferences folder from the Preferences folder inside the
System Folder on your startup disk to the Preferences folder inside the System Folder on the
new hard disk.

By default, the Print Server stores jobs in a folder inside the Print Server Preferences folder. If
you have set up the Print Server to use a different folder, you need to drag that folder to the
new hard disk.

Open the Startup Disk control panel and click the icon of the disk you want to use as the
startup disk.

Choose Restart from the Special menu.

The disk that you selected in step 11 becomes the startup disk. After the computer has
restarted, start the AppleShare IP Manager from the new startup disk.

If you are replacing your startup disk and if your computer is being used to run the Mail
Server, use the Mail Admin program to change the mail storage volume.

This step is not necessary if the AppleShare IP Mail Folder is not currently located on your
startup disk. For information on determining the current location of the AppleShare IP Mail
Folder, see the Mail Server section of AppleShare IP Help.

If you are replacing your startup disk and if your computer is being used to run the Print
Server, use the Print Admin program to change the folder in which jobs are stored.

For information on determining the folder that the Print Server is currently using to store
jobs, see the Print Server section of AppleShare IP Help.

If your computer is being used to run the Web & File Server, start the Web & File Server and
verify that all services are running as expected.
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Verify that folders are being shared correctly. If Web service is enabled, use the Web & File
Admin program to verify and set the location (if necessary) of the Web folder and
default.html file. If FTP service is enabled, verify that it is working correctly.

If your computer is being used to run the Mail Server, start the Mail Server.

Verify that the Mail Server is using the correct mail database by checking the Mail Server log.
For information, see the Mail Server section of AppleShare IP Help.

If your computer is being used to run the Print Server, start the Print Server.

Verify that the Print Server is working correctly by checking the Print Server log. For
information, see the Print Server section of AppleShare [P Help.

If you are replacing your startup disk, stop each AppleShare IP server and shut down your
computer. Remove the disk that formerly was the startup disk (making sure that the SCSI
chain is terminated correctly) and restart your computer.

Repeat step 15 through step 17 to verify that the servers are working correctly.
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